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Release Information

Release Information
This section contains information about the current release of Cognex Designer and its release history.

Security Requirements for VisionPro
The latest release of VisionPro and Cognex Designer requires the latest VisionPro drivers and the latest supported
VisionPro dongles, made by Wibu-Systems.
Always consult the Cognex VisionPro web page or installation documentation for up-to-date information on what dongle
to use with your current version of VisionPro.

About this Release
Cognex Designer 4.4.1 is a minor release to address a number of bugs primarily relating to the touch keypad and
TwinCAT:
l

Tested against VisionPro 9.7

l

Deployed application icons can be added via the Deployment Options dialog

l

Sample plugins added for Devices and WinForms HMI elements

l

Added the ability to query databases directly

l

The Merge Graphics Block has the option ignore missing graphics

Note: See the Release History on page 11 for a complete list of all the major capabilities that were introduced in the
previous releases of Cognex Designer.

PC Requirements
Cognex Designer shares the same PC configuration requirements that VisionPro supports. Please see the PC
Configuration Guide, which is accessible from the Windows Start Menu (Cognex > VisionPro > Documentation > English
> Hardware Manuals).
Note:
For a complete list of compatible versions of Cognex Designer and VisionPro, please visit the Cognex Designer
Support Website.

Operating System Requirements
Microsoft Windows Operating
System
Windows 10 (64-bit)

Service
Pack

English German Spanish French Japanese Korean
✓

✓

✓

✓

✓

Plugin Development Requirements
The following requirements are necessary for developing plugins for Cognex Designer 4.4.1:
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✓

Simplified
Chinese
✓

Release Information
l

Microsoft Visual Studio 2019 (16.8)

l

Microsoft .NET Framework 4.7.2
Note: Microsoft Visual Studio 2013 is NOT supported on the Windows Embedded 8.0 OS used on Cognex
Vision Controllers.

For detailed information about working with plug-ins, see the How To... Plugins topic.

Cognex Vision Controller Requirements
For information regarding the Cognex Vision Controller requirements, please consult the Cognex Designer Support
Website. The Technical Bulletins contain additional information about updating the Vision Controller to the latest release
of both Cognex Designer and VisionPro.

Web Browser HMI Requirements
Cognex recommends opening Web Pages developed in Cognex Designer with the following browsers:
l

Google Chrome™ browser, version 54 or greater

l

Internet Explorer version 11

Note:
l

l

For the best performance, Cognex recommends using Google Chrome version 54 or greater to view and
interact with your Web-based HMI.
Due to issues in Internet Explorer and Google Chrome, displaying HMIs in Web Browsers for a long period
of time (multiple days) can result in the browser window being non-responsive or the browser crashing.
Cognex recommends periodically restarting the Web Browser in this scenario.

About the Cognex ViDi Suite of Tools
Cognex ViDi Suite uses deep learning to accomplish tasks not previously possible using traditional machine vision
software libraries.
The Cognex ViDi Suite tools share a common engine, but each tool has a distinct focus:
l

Localization (Blue Locate tool)

l

Cosmetic inspection (Red Analyze tool),

l

Classification (Green Classify tool)

l

Hard-to-read OCR (Blue Read tool)

By using the ViDi plug-in, you enable deep learning integration capabilities with Cognex Designer.
See the ViDi documentation for complete information about the ViDi and Cognex Designer integration.

Migrating to this Release
This topic contains information about changes that may affect existing projects when migrating projects from the previous
release of Cognex Designer (Cognex Designer 4.3) to the current release of Cognex Designer (4.4.1).
l

Obsolete API
Change from:
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void CSharpScriptDefinition.RefeshObjectNames()
to
int CSharpScriptDefinition.RefreshObjectNames()
Plugin should be recompiled and have the signature updated.
Note: For more information about migrating from earlier releases, see Release History on page 11.

Resolved Issues
Cognex Designer 4.4.1 introduces multiple new or changed capabilities since 4.4.
This section describes changes and resolved issues.
Note: Change Request numbers (CR#) have been included (where applicable) to improve the tracking of issues
reported via Cognex Technical Support.
CR#

Issue

CDVP-817

Remove incomplete support for saving CDB files to remote sources (for example, FTP)

CDVP-921

TwinCAT Group write errors after changing plc variable name

CDVP-936

Re-adding lost database queries results in error messages.

CDVP-951

The argument 'description' of $FileSystem.ShowFolderDialog() doesn't work

CDVP-952

Gateway logs do not clear space

CDVP-965

Keypad - Clicking +/- makes the existing pre-set number disappear

CDVP-968

HMI Keypad mid point rounding changed from banker's rounding to away from zero

CDVP-1066

Textbox for Recipe Config string value ingredient is annoyingly small.

CDVP-1288

Closing keypad using touch causes keypad to reopen in some scenario

CDVP-1320

Correct password cannot exit Test Mode on a different user account

CDVP-1321

Fix total memory usage in performance profiler

CDVP-1324

Constantly closing and reopening VisionPro ToolBlock editor will cause Designer to crash

CDVP-1333

Non-instantiable parameters in a Designer ClickCommand will cause start-up errors and makes
Designer content irrecoverable for user.

CDVP-1406

Trying to connect TwinCAT device in Designer crashes when PLC has circular pointers

CDVP-1413

HMI.ShowKeyboard, the preset string would be erased when clicking on any key button

CDVP-1418

Designer crashes when using ListBox HMI control scrollbar

CDVP-1485

Extend the default OPC UA server certificate expiry to 10 years

CDVP-1495

Touch Keyboard not responding to touch events

CDVP-1525

Unable to save to a network path after long file path support was added

CDVP-1530

Access violation during ImgHttpRequestHandler

CDVP-1531

Changing the "Encoding" of a TCP connection via Reconfigure doesn't work.

CDVP-1535

Performance Profiler produces unusable logs when run under certain languages like DE.

CDVP-1545

TwinCAT TryWrite fail isn't logging which tag has failed

CDVP-1555

Gracefully handle ComputerInfo.FullName throwing

Backwards Compatibility and Known Issues
Cognex Designer 4.4.1 introduces multiple new or changed capabilities since 4.4.
The following tables describe all known issues and notable changes in Cognex Designer behavior.
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Backwards Compatibility
Behavior

Description

Saving Images with the
Image Recorder Block

As of release 4.4.1, Recording to a remote CDB file is no longer supported as an
option on the Image Recorder Block when storing files remotely.

OPC UA Server certificates
expiration dates

As of release 4.4.1, Cognex Designer OPC UA Server certificate expiration has
increased from one year to 10 years.

Rounding used by the
touchscreen

As of release 4.4.1, the rounding at midpoints used by the touch keypad has been
changed from Bankers' rounding / half to Round-away-from-zero. Some examples:
Input

4.4.0

4.4.1

1.4

1

1

1.5

2

2

1.6

2

2

2.4

2

2

2.5

2

3

2.6

3

3

Warning appears when
license is about to time out

As of release 4.3.1, when using a Development License, Cognex Designer provides a
warning 30 minutes before license expiration, allowing users to properly test and save
their project in time.

Warning if AVX2 instruction
set is not supported on PC

As of release 4.3.1, once a project is loaded, the Output window shows the following
warning if the CPU of the computer running Cognex Designer does not support the
Advanced Vector Extensions 2 (AVX2) instruction set:
AVX2 instruction set is not supported on this machine: VisionPro 3D
functionality will not be available.
In such cases, the 3D features of VisionPro will not be supported, and using them in
the project can result in crashes or errors.

Changed image format
shown on WebHMI

As of release 4.3, Cognex Designer sends 8-bit grayscale images to Web Pages
instead of 24-bit grayscale images to improve performance.

Change in the default
behavior of the VisionPro
Display element

As of release 4.3, the VisionPro Display control element has been enhanced to auto-fit
the images and graphics appearing on it.

Updated .NET Framework
version for Plugin
development

As of release 4.3, developing plugins for Cognex Designer requires Microsoft .NET
Framework 4.7.2 to be installed.

New Garbage Collection
Method

As of release 4.1, Cognex Designer employs a background Garbage Collection
technique by default for all new projects. This may result in longer task execution time
in Test Mode than in earlier versions, such as 2.x. Therefore, always benchmark using
a deployed application. See the Scheduling Garbage Collection topic for more
information.

Legacy project sequences
replaced with Sub Tasks

As of release 4.0, legacy Cognex Designer 2.x project sequences are replaced with a
Sub Task.

Known Issues
Issue

Description

Designer project file permissions do not allow access by other user accounts. To work
Designer projects cannot be
opened by multiple users on a around this issue, choose either of the following actions:
shared drive
l
Make a copy of the project file and replace it in the same directory and replace
it in the same directory from the user account attempting to access it
l

Explicitly add a suitable user group to the file permissions with Full Control.
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Designer crashes after 1 hour Using a DSMax in a Designer project will crash after one hour if the Web HMI is
when using a DSMax camera enabled. To work around this issue, choose either of the following actions:
with Web HMI enabled
l
Disable the WebHMI.
l

Add the environment variable COGNEX_LOG_APG_FG1_DLL_LEVEL and
set the value to 5.

Unsupported ports when
accessing the WebHMI with
Google Chrome or Mozilla
Firefox

The Enable Web Server setting (available through Project > Settings > Web HMI)
does not work with Google Chrome and Mozilla Firefox if the port is set to 79.
Configure a different port number to solve this problem.

WebHMI Inactivity Timeout
does not work in Test Mode

The Inactivity Timeout setting (available through Project > Settings > Web HMI)
currently only works when accessing a deployed project through a web browser, and
does not work in Test Mode.

Handling Database files while When creating, importing or deleting Databases in Cognex Designer, the following
creating, importing or deleting limitations apply:
Databases
l
Removing a Database from a Cognex Designer project does not remove the
underlying Database file.
l

When you create or import a new Database, using the name that matches an
existing *.db3 file will result in having the new Database loaded with the table
structure of the previous database.

Auto-Camera detection
limitation

Auto-Camera Detection only functions when Creating a New Project with Project
Types.

Errors when handling large
recipe configurations

In Recipes, when loading a large configuration (for example, the file size of the
corresponding .json file is greater than 550M), an error such as Array dimensions
exceeded supported range results.

Anti-Virus software

If anti-virus software is enabled for real-time protection it may also perform disk scans
at a user-specified time. The disk scans may interfere with busy vision software
applications. If so, consider disabling anti-virus software, or managing behavior in a
manner appropriate for the application.

Expression Builder function
does not get updated.

When an ItemAt($index, $array) function is constructed in the Expression
Builder, it will only update the returned value when the value of the $index tag
changes, or a new array is assigned to the $array tag.
The following C# script statements illustrate how to trigger a value change event:
$index++;
$array = { "one", "two", "three" };
The following C# script statement will not trigger a value change event:
$array[1] = "new value";

Test Mode changes on Pages
persist in Program Mode

If an element on a Page (e.g. CheckBox, TextBox, etc.) is modified while in Test Mode,
after exiting Test Mode, the element will not return to its state prior to entering Test
Mode. To do so, the Designer OnStartup Script must be used to explicitly set the
default values of Page elements. For example, if a Page contained a TextBox which
should be blank at startup, the script would be:
$Pages.Page.TextBox.Text = string.Empty;

Uninstalling/Reinstalling
software on a Cognex vision
controller

In the event that the default installations of VisionPro or Designer need to be
uninstalled and then newer versions installed, if a black desktop (no Cognex
wallpaper) and a blank, blue Taskbar is encountered after the initial reboot after
uninstalling/reinstalling, press the Windows Logo key to return to the Start screen, and
then select the Desktop tile/icon to return to the correct Desktop.
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Changing the primary
language of the operating
system on a Cognex vision
controller

If the primary language of the Operating System on a Cognex Vision Controller is
changed (e.g. from English, the default language, to Simplified Chinese), the Vision
Controller will need to be restarted. In the event that the desktop appears without the
Cognex wallpaper and a blank, blue Taskbar is encountered after the reboot, press
the Windows Logo key on your keyboard to return to the Start screen. Next, select the
Desktop tile/icon to return to the correct Desktop.

A startup issue incorrectly firing Precision I/O Events can occur in Industrial
Startup Issue resulting in
incorrectly firing Precision I/O Communications if the following conditions are met:
Events
l
The output mapping of the configured industrial communications connection is
set to falling-edge trigger.
l

l

The bit state is low.
Another signal transition causes the industrial communications protocol to
push an update through the logic.

In such cases, the mapping will false-trigger one time and incorrectly fires the discrete
event.
This only occurs when the bit state starts low, and the mapping is set to falling-edge
trigger, or the bit state starts high, and the mapping is set to rising-edge trigger.
Modifying VisionPro and Tool
Block Editor Page Controls
while a Task is running

If a Page contains a VisionPro Tool Editor or VisionPro ToolBlock Editor element, they
should be configured to not allow user interaction while the application sequence is
running. Changes to these two types of controls can be made when the application is
being modified at design time in the development environment, or in a deployed
application, but only when the sequence using the tools is not running.

Unsupported database data
types

Cognex Designer does not support the decimal, geography, hirachyid, image, money,
numeric, smallmoney , sql_variant, time, timestamp and xml data type parameters.
When creating a database, ensure that these types are not used for columns,
otherwise Designer will be unable to connect to the database.
Cognex Designer only supports a sub-set of data types: bigint, binarybit, char, date,
datetime, datetime2, datetimeoffset, float, int, nchar, ntext, nvarchar, real,
smalldatetime, smallint, text, tinyint, uniqueidentifier, varbinary, varchar. Use
Microsoft® SQL Server® 2008 Management Studio or later to create and edit SQL
Server databases.

Return statements in Script
Editor

When wanting to use a return statement to exit a script function, use the return
null; statement, instead of the return; statement. In the Script Editor, scripts must
always return an object, even though the signature of the script function returns void.

FFP Offline requested Task
Triggers for "Online" and
"Offline" status

When implementing industrial communications protocols, consider that within Cognex
Designer, the OfflineRequested event is mapped into both a scriptable point called
FFP Offline Requested and a Task Trigger called Devices.
{CommCardName}.FfpOffineRequested. During execution, if the OfflineRequested
event is fired, it will run the script registered to the scriptable point called FFP Offline
Requested.
At this point, the user can access the ReturnToPreviousState member of the
argument, and determine the state of the device (False = Offline and True = Online).
After this has occurred, the event triggers the FfpOfflineRequested Task Trigger.
However, in this case, there is no way to determine the requested state, so any Task
registered to run as a result of this trigger will be executed, regardless of the state.

OPC UA Plugin compatibility
with older Windows versions

If Cognex Designer 4.4.1 is used on a machine running Windows 7 or Windows
Embedded 8, the OPC UA Plugin works only if the .NET Framework 4.7.2. Runtime
package has been installed for the operating system. This limitation does not impact
machines running on Windows 10.
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Product and Upgrade Codes
Designer API

Product Code

VisionPro .NET

Deep
Learning

Comments

4.4.1

4.4.1 1E940356-3D1A-43C5-90F7-FFEC4EBEA89D

9.7

4.7.2

Comms
plugins
upgraded
to: Modbus
(1.2.0),
TwinCAT
(3.0.4), OPCUA (1.1.1)

4.4.0

4.4.0 9BA1325F-27A4-4159-8D9D-4AA3E1BDC0E1

9.6 SR2

4.7.2 VPDL 1.1

Designer no
longer
enforces any
specific
version of
VisionPro.
TwinCAT
plugin
upgraded to
3.0.3, Modbus
plugin
upgraded to
1.1.3, OPCUA plugin
upgraded to
1.1.0.

4.3.1

4.3.2 7E61223A-7C94-4EB2-9D64-E969C854CD5A

9.6

4.7.2 VPDL 1.01.0.1

ViDi Plugin no
longer
supported.
Replaced by a
new
DeepLearning
plugin.
TwinCAT
plugin
upgraded to
3.0.2, Modbus
plugin
upgraded to
1.1.2. OPC UA
released 1.0.2

4.3.0

4.3.1 A1253D2A-62D4-4A1D-A129-7FBE718925BD

9.5 SR2

4.7.2 VIDI 4.1.0 4.1.3

Comms
plugins
upgraded to
Modbus
(1.1.1),
TwinCAT
(3.0.1), OPC
UA (1.0.1).

4.2.0

4.3.0 40ED1DFC-4320-4E5F-AB29-E2FE589C376C

9.5 SR1

4.7.1 Unavailable Modbus
(1.1.0),
TwinCAT
(3.0.0), OPC
UA (1.0.0)
plugins first
included for
4.x

9

Release Information
Designer API

Product Code

VisionPro .NET

Deep
Learning

4.1.2

4.2.0 40ED1DFC-4320-4E5F-AB29-E2FE589C376C

9.5

4.7.1 VIDI 3.4.1

2.7

3.5.1 54A2FBEA-3ADE-4749-A6D9-CF8A711739C

9.2

4.6

N/A

2.6

3.5.0 E2951431-1CD9-4B62-ADF4-43A5FD71C387

9.1

4.6

N/A

2.5 PR5

3.1.0 BE5CEE3F-827E-46B6-B5FF-B1367B2CF87C

9.0

N/A

2.1

3.0.0 588BE36C-5F7E-440D-BEA3-B443FC39A9FF

8.4 SR3

N/A

Comments

Note:
l

l

Designer 4.4 and later releases support VisionPro releases 9.4 to 9.*. The column VisionPro indicates the
version used for testing.
Designer 2.x product codes represent the x64 version only; not the x86.

Supported Hardware
The following acquisition platforms, communication cards, cameras and sensors are supported by Cognex Designer.

Supported Acquisition Platforms and Communication Cards
l

Cognex Vision Controller

l

Cognex CC24 I/O Communication Card

l

Cognex CFG-8704e Frame Grabber Card

l

Cognex CFG-8724 Frame Grabber Card

l

GigE Vision

l

MVS-8602e CameraLink

l

Acquisition Interface Kit (AIK)

Supported Cameras and Sensors
l

Cognex 2D Industrial Cameras (CIC cameras)

l

Cognex 3D Displacement Sensors (DS900 series and DS1000 series)

l

As well as those supported by VisionPro for the Acquisition Platforms listed above.

Designer Sample Projects
Designer includes several sample projects to help illustrate how to use the program, and how different elements of
Designer fit together to create modern machine vision application solutions. For more information on opening the sample
projects, see the Sample Projects topic.
Tip: For additional information and sample codes and projects, please visit the Cognex Designer Support Site. A
link to the Cognex Designer Support Site is also included in the Help menu.
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Note:
Subject to Cognex Corporations terms and conditions and license agreement, you are authorized to use and
modify this source project in any way you find useful, provided the Software and/or the modified Software is used
solely in conjunction with a Cognex Machine Vision System. Furthermore you acknowledge and agree that Cognex
has no warranty, obligations or liability for your use of the Software.
This sample program is designed to illustrate certain Cognex Designer features or techniques in the simplest way
possible. It is not intended as the framework for a complete application. In particular, the sample program may not
provide proper error handling, event handling, cleanup, repeatability, and other mechanisms that a commercial
quality application requires.
Copyright © 2014 - 2022

Release History
The following topic lists the features and resolved issues in the previous three releases of Cognex Designer. For the full
list of features and resolved issues covering all earlier releases of the product, see the Release History topic of the
Cognex Designer User Guide.
Note: Cognex Designer is backward compatible, which means that projects created with earlier Designer versions
can be opened and edited. Designer does not support loading projects created by a newer version of Designer in
an earlier version.

Cognex Designer 4.3 Release
Cognex Designer 4.3 introduces multiple new or changed capabilities since the previous generally available (GA)
release (4.2). See the below list for more information.
l

l

l

l

l

Supports VisionPro 9.5 SR2
Editing Vision Tools in Runtime through the WebHMI: Adjust and/or fine-tune the Vision Tools of your project
during runtime by modifying them remotely through the WebHMI.
Ease of Use Enhancements: The Cognex Designer user interface has received several graphical
enhancements (such as new category icons or window naming changes) along with the following new features:
o

Added a new Web Pages Browser, allowing you to quickly access the list of WebHMI pages created in the
project.

o

Added the ability of configuring a startup web page for the project through the Web Pages Browser or the
Project Explorer. See the Configure a Startup Web Page topic for more information.

o

Updated the Script Editor with new buttons and hotkeys for quickly commenting out lines of code, or
uncommenting existing comment lines.

o

Updated the Task Editor and the Tag Manager to support directly assigning tags to compatible Page and
WebPage user input elements. See the Assign a Pin to a Page or Web Page Control and the Tag
Manager topics for more information.

New Sample Plugins: Develop your own custom Task Blocks, HMI elements, or HMI chart control elements with a
set of sample plugins supplied with the Cognex Designer 4.3 installation. See the Use Sample Plugins topic for
more information.
Shared Project Resources: Share project resources between your development project and deployed
application with the new Share Resources with IDE setting of the Deployment dialog. See the Deployment
Options topic for more information.
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l

Test Mode Password: Protect your Cognex Designer Development project by specifying a password for exiting
Test Mode. See the General topic for more information.

Cognex Designer 4.2 Release
Cognex Designer 4.2 introduces multiple new or changed capabilities since the previous generally available (GA)
release (4.1 PR2). See the below list for more information.
l

l

l

l

Supports VisionPro 9.5 SR1
Optional Communications Plugins - Enhance the industrial communications capabilities of your vision project
with the following optional industrial communications protocols:
o

Modbus - With a set of new Devices, Task Blocks and $ functions, the Modbus plugin adds support for the
general-purpose Modbus communications protocol in Cognex Designer.

o

OPC UA Server - Represented in the Devices node of the Project Explorer, the OPC UA Server
functionality brings support for the OPC UA cross-platform machine to machine communication protocol,
allowing you to read and write exposed project Tagsand $ Functions through OPC UA client applications
on the network.

o

TwinCAT - Interact with Beckhoff® TwinCAT® 2 or 3 software systems through the ADS/AMS protocol by
setting up a TwinCAT client device in Cognex Designer, and performing synchronous or asynchronous
read/write operations through TwinCAT tags and $ functions.

FTP Client Support - Avoid local storage limitations by setting up an authenticated FTP connection in the Project
Explorer, and uploading acquired images to a remote FTP server with the enhanced Image Recorder task block.
Image File Device Enhancements - Get a better picture of simulated image acquisition by utilizing the
enhancements of the Image File device. Use the new device tags in tandem with the Watch list window to get upto-date information on the number of images used for emulation, the currently loaded image, and more.

Cognex Designer 4.1 PR2 Release
l

l

l

l

l

l

Supports VisionPro 9.5
Performance Monitoring - Browse performance statistics relating to your Cognex Designer application's task
execution time, memory usage, and garbage collection details, using the Analyzing Application Performance with
Performance Profiler, which runs and monitors tasks in a project and produces a report and CSV file. See a
breakdown of block execution times in a succinct bar-graph format by Displaying Block Time Performance Data.
Efficient, Less Disruptive Garbage Collection - The Resource-intensive Dynamic Garbage Collection present in
releases 4.0.0 and before has been deprecated. Settings have been changed to allow Background Garbage
Collection which can lessen performance impact. This new Garbage Collection setting is enabled by default for
all new projects. See the Scheduling Garbage Collection topic for more information.
Performance Tuning - Tune performance metrics by Scheduling Garbage Collection and implementing
processor Load Balancing Using Core Assignments.
Graphics Consolidation - Combine multiple supported graphics and image formats into a single CogRecord for
convenient and efficient processing in Cognex applications. See the VisionPro Tool Block Graphics Options topic
for complete details.
Project Types - Cognex Designer now supports drastically Accelerating Development With Predefined Project
Types. With a single click, launch a fully defined project template that can be quickly customized. Project Types
enable you to spend more time developing vision applications and less time creating HMIs or writing scripts.
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l

Getting Started Tutorials - Walk through every phase of creating a standalone Vision Application with the new
Getting Started documentation section that lets you learn at your own pace, with only the content that applies to
your needs.

Cognex Designer 4.0 Release
Cognex Designer 4.0.0 introduces multiple new or changed capabilities since the previous generally available (GA)
release (2.7).
l

l

l

l

l

l

Supports VisionPro 9.3
Supports Cognex ViDi Suite - Supports Cognex ViDi Suite, which enables Deep Learning programming within
Cognex Designer. The ViDi Suite is a separate product and requires an additional license and installation.
Please see the Cognex Deep Learning-based Image Analysis page or contact your sales representative for more
information about the ViDi Suite optional plug-in for Cognex Designer.
WebHMI - With WebHMI, access your deployed application through a standard browser, enhancing user
productivity. Run your remotely hosted applications, free from the constraints of local sites and domains. Drag
and drop a display or viewer object on customizable Web Pages and bind objects to any tag, function, or query.
Create your own scripts to add advanced functionality to your WebHMI applications. Deliver your vision
application securely with support for Web authentication and set timeout values for your WebHMI log-ins. For
more information, see WebHMI: A Functional Overview.
Improved IDE and New Graphical Editing Shortcuts - Featuring a high-resolution rich-text interface, ability to
add multi-line text to labels, and other convenient graphical shortcuts for Working With Task Blocks and Working
With Script Blocks.
Localization - Manage multiple-language translations from a single interface with Project Localization.
Launch Page - Use the Cognex Designer Launch Page to quickly open new projects, saved projects or sample
projects with a few mouse clicks.

Cognex Designer 2.7 Release
Cognex Designer 2.7 introduced multiple new or changed capabilities since the previous generally available (GA)
release of Designer (2.6):
l

Supports VisionPro 9.2

l

No longer supports x86 (32-bit)

Resolved Issues in Designer 2.7
CR#

Issue

44464 Serial device not correctly processing byte data

Release Migration History
Migrating projects from Cognex Designer 2.1 to Designer 2.5
This topic contains information about changes that may affect existing projects when migrating projects from Cognex
Designer 2.1 to Designer 2.5 PR5.
l

Using the Updated VisionPro Display 3D and New VisionPro Display 3D Status Bar
The VisionPro Display 3D control has been updated with the new control introduced in VisionPro version 9.0,
and VisionPro Display Status Bar 3D is a new control in Designer 2.5. This will affect projects that were using the
VisionPro Display 3D control in their HMI.
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The following considerations apply to the new controls:
l

l

l

l

l

The previous VisionPro Display 3D included a right-click context menu which could be used to display the
X, Y and Z coordinates either on the display itself, or in a built-in status bar (or both). These options have
been removed from the new VisionPro Display 3D control. Now, in order to display the coordinates, you
must add a VisionPro Display 3D Status Bar and configure the Subject property to the VisionPro Display
3D.
The VisionPro Display 3D does not support displaying 2D images as height maps; these types of images
will not be displayed and a warning will be shown, instead.
The VisionPro Display 3D does not work when using a Windows Remote Desktop Connection. Third party
options, such as VNC® or TeamViewer, may be used.
The VisionPro Display 3D requires a VisionPro security bit; therefore, previously created Designer
projects will need to be updated with this security bit to continue to work correctly.
The VisionPro Display 3D will not work on virtual machines.

Migrating projects from Cognex Designer 2.0 to Designer 2.1
l

New Project File Format
The file format of Designer projects has been modified, and when projects developed in previous versions of
Designer are opened and loaded in Designer 2.1, they will automatically be converted to the new format. Projects
saved in Designer 2.1 cannot be opened in previous versions of Designer. For more information, see the Cognex
Designer Version Compatibility topic.

l

Recipes Folder Location
For Designer 2.1, the folder location of Recipes will no longer be editable, and must be located in the following
directory: <ProjectName>\Recipes\<RecipeName>
Note: If you had edited the Recipe directory location in 2.0, you must manually move your Recipe folder into
the new directory location.

l

Recipes File Format Conversion
Recipes will only be converted from XML to JSON format when they are being loaded through the
System.Recipes.{RecipeName}.Load and the System.Recipes.{RecipeName}.LoadFile methods.

l

New Template File Extension in Designer 2.1
For the Designer 2.1 release, the Template file extension was updated from .cdt to .cdtx. The first time that you
start Designer 2.1, all of your .cdt template files will be automatically converted to .cdtx files, with the same name.
Both files will exist in the Templates directory (C:\Users\<username>\Documents\Cognex Designer\Templates).
If you delete a .cdtx file, you will also need to delete the .cdt file. Otherwise, when you start Designer 2.1 again, or
refresh the tree view in the Template Browser, Designer will automatically perform the conversion process again
and recreate another .cdtx file, based on the .cdt file.

l

Read IO and Write IO Block Visible Pins State Change
In Designer 2.0, it was possible to add and configure Read IO and Write IO blocks with Visible Pins, even though
they did not have the Selected Device property set to a supported device (Cognex Communication Card or Vision
Controller). If a project is loaded in Designer 2.1 which has these types of Read IO and Write IO block
configurations, the pins will not be visible until the Selected Device property is set, and any links between the
pins will disconnected and have to be reset.

Migrating projects from Cognex Designer 1.0 to Designer 2.0
l

MessageID Pin Type Changed
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The MessageID pin of the Notify PLC block in AsyncSoftEventComplete has been changed from a int (Int32)
data type to a long (Int64) data type.
Note: This does not cause any issue with existing projects.
l

Opening 1.0 or 1.0 PR1 Projects in Designer 2.0
When a Designer 1.0/1.0 PR1 project is opened in version 2.0, the UsedAcquisitionIDCollection pin of the
Notify PLC block in InspectionCompleteMode will be replaced with two other pins: AcquisitionID0 and
CameraIndex0. If you have more than one cameras, you can set it in the block’s Configuration UI.

l

"Assign New Tag" Option
Starting with Designer 2.0 the Assign to New Tag option on a pin does not initialize the created tag with the datatype’s default value.

l

Read IO Block New Pin
A new pin has been added to the Read IO Block: PrioState.

l

Expression Builder
The Expression Builder has been revamped. It is recommended to run a project verification that should identify
any expressions that are no longer compatible.

l

Opening 1.0 projects that have WriteIOBlock with pins
When an 1.0 project is opened in version 1.0 PR1, the existing "DS1000OutputBank0Line0"
"DS1000OutputBank0Line1" pins of a WriteIOBlock will be replaced with new empty pins. If the pins were
assigned to tags, the connection to the tags will be no longer available. This means that the user has to reassign
the pins to the tags (since they are still available in Tag Manager).
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l

Migrating Plugins From Designer 1.0 to 1.0 PR1
After Designer 1.0 PR1 is installed, all new projects created using either 1.0 or 1.0 PR1, will use the 1.0.1
VisionPro Plugin. Old projects that use VisionPro Plugin 1.0.0.0 will need to be updated to VisionPro Plugin 1.0.1,
using the Edit Project Plugins option from the Launcher. Click Edit Project Plugins, select the desired .cdp
project file in the Open file dialog box, and check/uncheck the desired plugins.
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Previous Product and Upgrade Codes
This topic lists the product and upgrade codes for the previous three Cognex Designer release. For the full list of codes
covering all earlier product versions, see the Previous Product and Upgrade Codes topic of the Cognex Designer User
Guide.

Cognex Designer 4.3
l

API Version: 4.4.0

l

Upgrade codes
l

l

x64 - 84F14F46-58D4-4B7C-A963-4C7F1D57D1DB

Product Codes
l

X64 - A1253D2A-62D4-4A1D-A129-7FBE718925BD

Cognex Designer 4.2
l

API Version: 4.3.0

l

Upgrade codes
l

l

x64 - 84F14F46-58D4-4B7C-A963-4C7F1D57D1DB

Product Codes
l

X64 - 40ED1DFC-4320-4E5F-AB29-E2FE589C376C

Cognex Designer 4.1 PR2
l

API Version: 4.2.1

l

Upgrade codes
l

l

x64 - 84F14F46-58D4-4B7C-A963-4C7F1D57D1DB

Product Codes
l

X64 - 40ED1DFC-4320-4E5F-AB29-E2FE589C376C
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Cognex Designer 4.0
l

API Version: 4.1.0

l

Upgrade Codes
l

l

x64 - 84F14F46-58D4-4B7C-A963-4C7F1D57D1DB

Product Codes
l

x64 - 21B3FB72-8EEE-4B76-9D37-26EE0ED5F464

Cognex Designer 2.7
l

API Version: 3.5.1

l

Upgrade Codes
l

l

x64 - 9DBBCE96-D0AB-482E-B207-730F83879934

Product Codes
l

x64 - 54A2FBEA-3ADE-4749-A6D9-CF8A711739C
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Legal Notices
The software described in this document is furnished under license, and may be used or copied only in accordance with
the terms of such license and with the inclusion of the copyright notice shown on this page. Neither the software, this
document, nor any copies thereof may be provided to, or otherwise made available to, anyone other than the licensee.
Title to, and ownership of, this software remains with Cognex Corporation or its licensor. Cognex Corporation assumes
no responsibility for the use or reliability of its software on equipment that is not supplied by Cognex Corporation.
Cognex Corporation makes no warranties, either express or implied, regarding the described software, its
merchantability, non-infringement or its fitness for any particular purpose.
The information in this document is subject to change without notice and should not be construed as a commitment by
Cognex Corporation. Cognex Corporation is not responsible for any errors that may be present in either this document or
the associated software.
Companies, names, and data used in examples herein are fictitious unless otherwise noted. No part of this document
may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, nor
transferred to any other media or language without the written permission of Cognex Corporation.
Copyright © 2014 - 2020. Cognex Corporation. All Rights Reserved.
Portions of the hardware and software provided by Cognex may be covered by one or more U.S. and foreign patents, as
well as pending U.S. and foreign patents listed on the Cognex web site at: cognex.com/patents.
The following are registered trademarks of Cognex Corporation:
Cognex, 2DMAX, Advantage, AlignPlus, Assemblyplus, Check it with Checker, Checker, Cognex Vision for Industry,
Cognex VSOC, CVL, DataMan, DisplayInspect, DVT, EasyBuilder, Hotbars, IDMax, In-Sight, Laser Killer, MVS-8000,
OmniView, PatFind, PatFlex, PatInspect, PatMax, PatQuick, SensorView, SmartView, SmartAdvisor, SmartLearn,
UltraLight, Vision Solutions, VisionPro, VisionView
The following are trademarks of Cognex Corporation:
The Cognex logo, 1DMax, 3D-Locate, 3DMax, BGAII, CheckPoint, Cognex VSoC, CVC-1000, FFD, iLearn, In-Sight
(design insignia with cross-hairs), In-Sight 2000, InspectEdge, Inspection Designer, MVS, NotchMax, OCRMax,
PatMax RedLine, ProofRead, SmartSync, ProfilePlus, SmartDisplay, SmartSystem, SMD4, VisiFlex, Xpand
Portions copyright © Microsoft Corporation. All rights reserved.
Portions copyright © MadCap Software, Inc. All rights reserved.
Other product and company trademarks identified herein are the trademarks of their respective owners.
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